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CHAPTER 33

Senozon Via

Marcel Rieser

33.1 Basic Information

Entry point to documentation:
http://matsim.org/extensions → Via
Invoking the module:
Standalone GUI, double-clickable jar �le
Selected publications:
http://via.senozon.com → Download → manual

33.2 Introduction

Via is an application to visualize and analyze MATSim simulation results. Unlike MATSim,
Via is not open source; it is developed as a proprietary commercial so�ware by Senozon AG, an
ETH Spin-o� company founded by two former PhD students involved in MATSim development.
Shortly a�er the company was founded, �rst (potential) client presentations began; the lack of vi-
sual material was an obvious handicap. Explaining to customers that all answers to their questions
were contained in a huge events �le was not satisfactory; pictures or even animations made it much
easier for them to understand. Thus, work on a visualization tool started as soon as the company
was set up. Initially planed as a purely internal tool, it quickly became clear that a graphical visu-
alization and analysis tool would also bene�t other users of MATSim. A�er a beta test phase with
selected MATSim users in Spring 2011, the �rst version ofViawas released in July 2011. Since then,
the list of features provided by the application has grown continuously.
Via is written in Java and thus works on any platform able to run MATSim. For easier deploy-

ment, the application comes as double-clickable, native executable on Windows and Mac OS X,
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partially hiding its Java nature. A limited version is available for free and can be downloaded from
the product website (senozon AG, 2015). Di�erent licenses are available for commercial usage or
for research or educational purposes to serve di�erent user group needs.
Via includes some general functionality that most people will use in the core application, like

visualizing networks, facilities, vehicles and activities. Optionally available plugins provide addi-
tional features o�en relevant only to specialized user groups. This includes functionality related
to public transport, comparison with car counts, using web maps like Google Maps or OSM as
background, aggregation analyses, or movie recording.
Via allows customization of its window. The following descriptions refer to elements as

they are placed in the default layout. The default con�guration can be re-created by choosing
Reset Window State from the Window menu in Via.

33.3 Simple Usage

Via di�erentiates between data sets, and how the data is visualized. It does so by managing data
sources (typically MATSim �les like network.xml or events.xml), and layers (e.g., displaying the
network, vehicles, activity locations). A layer can use more than one data source for its visualization
purposes (e.g., a network and some data from the events), and a data source can be used by multiple
layers (e.g., events can be used by many di�erent layers to visualize di�erent things like vehicles,
activities, link volumes, etc).

By default, Via’s window looks similar to the one shown in Figure 33.1. To add a �le as a data
source, the �le can either be drag-and-dropped onto the layers list le� of the black visualization
area, or by choosing Add Data... from the File menu. To add a layer, the little plus icon in the
lower le� of the window can be pressed, or by choosing Add Layer... from the File menu. To get
started, it’s usually best to add a network and (small) events �le from MATSim to Via, and create a
Network layer and a Vehicles layer.

Elements shown in the visualization area like the network or vehicles can be queried. Queries are
usually provided by layers, made available with buttons with question-mark icons. Clicking

Figure 33.1: Via’s window with default layout and a network query being shown.
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such an icon activates the corresponding query mode, and any subsequent click on the visual-
ization area will run the query. Query results are shown on the right side of the visualization area.
Figure 33.1 shows a network query for links. One query is special, globally available, and not linked
to a layer: querying an agent plan. This query is available from the toolbar, next to the icon, to shi�
the visualization view around.

Once a query has been made, Via o�en allows another query based on the current query results.
By right-clicking in the visualization area, a pop up menu appears with more options regarding
the last query, as well as additional possible queries. Examples are: Select Link Analysis given
a link, Select Facility Analysis given a facility, List Transit Lines that use a given link, or
List Passengers if a transit vehicles was queried in the �rst place.

33.4 Use Cases and Examples

33.4.1 Agent Visualization

The animated visualization of agents moving around in the modeled area was one of the main
features in Via’s original development. To do this, Via needs only the network.xml and events.xml

�les from a MATSim run as data sources. For the visualization, a Network layer, Vehicles layer and
activities layer must be created. With this setup, vehicles will move around in the visualization area
as time progresses, and agents performing activities will be represented as colored dots.

The visualization can be further customized; with the addition of a population.xml �le, more
detailed activity coordinates can be loaded to obtain a better distribution of activity locations
(MATSim’s events �le does not contain coordinates for activities, only the assigned link ID. So by
default, all activities taking place on a link are �rst shown at the location of the link’s to-node).
Vehicles and groups of vehicles can also be styled di�erently; it is possible to visualize transit
vehicles with a square shape with colors representing the occupancy of the vehicles, pedestrians
or cyclists in a multi-modal simulation can be shown as circles and private cars can be displayed
with a triangular shape with colors representing their absolute speed or their speed relative to the
allowed maximum speed on their current link (see Figure 33.2). As mentioned above, arbitrary
groups of vehicles can be styled di�erently, which is useful to highlight special agents, e.g., when
simulating a �eet of electric vehicles, a car sharing �eet, or agents simulated with special routing
guidance.

It is also possible to load arbitrary attributes for agents and then use those attributes for visu-
alization purposes, e.g., having di�erent colors for vehicles driven by agents who are employees,
have a high income or are within a certain age range.

33.4.2 Facility Analysis

Activity facilities allow for very detailed modeling in MATSim, especially considering the
functionality provided by the destination innovation module (Chapter 27). Via provides several
unique ways to analyze the mobility e�ects to and from facilities.

For each facility, a detailed analysis can be performed showing the number of agents arriving at,
departing from, or staying at a facility over the simulated time. The numbers can be di�erentiated
by the type of activity the agents perform at the facility, by the transport mode they arrive or depart
with, or by other arbitrary agent attributes loaded by users.

An alternative analysis is similar to the—for transport planners—well known Select Link

Analysis, but designed for facilities: the Select Facility Analysis. This analysis shows the
combined link loads produced by agents arriving or departing at a facility, showing the starting
location for agents visiting a speci�c facility and what routes they use. Figure 33.3 shows such an
example.
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Figure 33.2: Vehicles in Via: Green triangular symbols represent private cars, pink rectangular
symbols public transport vehicles.

Figure 33.3: Select facility analysis: Links used to travel to and from a facility are highlighted.

33.4.3 Public Transport Analysis

The public transport plugin provides many di�erent functions for analyzing public transport sim-
ulations. It starts with providing the speci�ed vehicle types as agent attributes, so the vehicles can
be di�erently visualized, based on the vehicle type they represent. Also, the absolute or relative
occupancy of a transit vehicle is provided as attribute, allowing transit vehicles to be visualized
accordingly. For stop locations, the number of passengers waiting for a bus or train can be plotted
over the time of day, and the occupancy along a bus or train route can be visualized.
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Figure 33.4: Passenger �ows on a transit line.

A special, but very useful visualization is the Route Flow analysis. This shows, in a visually
appealing way, the number of passengers traveling between two stops along a route—for all possible
stop combinations. Figure 33.4 shows an example of such a route �ow with the route of the transit
line shown in the background. It is clear that the demand on the bus route is more or less split in two;
a �rst travel demand up to about the �rst third of the route, and then it again collects passengers all
wishing to go to one of the last stops along the route. This could indicate that it might make sense
to split the line in two.

33.4.4 Scenario Comparisons

A typical use of MATSim is simulating a base case and then one or more case studies. Compar-
ing scenarios then becomes an important step in the analysis of the di�erent case studies. Via
allows comparison of the link volumes of two scenarios visually by coloring the network with the
absolute or relative di�erence of the link volumes between two models. In the future, other di�er-
ences like average speeds will supported too. The di�erences are time-dependent, aggregated over
time intervals as small as 15 minutes.

33.4.5 Aggregating Data

While MATSim requires and produces a lot of disaggregated data, it is still o�en necessary to
aggregate data to make statements or predictions about a simulated scenario. Via provides a pow-
erful mechanism to easily build arbitrary aggregations of available data. Such data can be either
point data (like activity locations, trip start locations, GPS points or any other spatial point data)
or origin-destination data (like trips with a start and end location, or the relation of an activity
location to the home location of the agent performing the activity). While Via provides: activity
locations, trip start and trip end locations, facility locations (automatically) as point data sources
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Figure 33.5: Aggregation analysis: Number of performed activities during the whole day.

for aggregation, and the trips performed by agents as O-D data sources, any tabular custom data
with coordinate attributes can also be used for this.

Data can be aggregated into a rectangular or hexagonal grid, where the cell-size can be speci�ed
by the user, or into arbitrary zones provided as ESRI (Environmental Systems Research Institute)
shape �le by the user. The data points can be �ltered by any of the available attributes, and the
aggregation can either just count the data points in each region, or build the sum, the minimum
or maximum or average of a data points attribute.

With the activity locations provided by an Activities Layer, the following (and more) aggrega-
tions are possible:

• show number of performed activities per region,
• show number of performed work activities per region,
• show number of work activities starting a�er 10 am per region, and
• show average duration of work activities starting a�er 10 am per region.

Similarly, with trip data provided by a Vehicles layer, the following exemplary aggregations are
possible:

• show number of trip starts per region,
• show number of trip starts with mode “car” per region,
• show percentage share of trips starting with mode “car” in a region, compared to all trips

starting in that region, and
• show average duration of trips starting with mode “pt” in a region a�er 11 am.

By using custom data tables, e.g., containing more information about trips, i.e., the ’from and to’
activity types they connect, the number of line switches if it is a public transport trip (this requires
the aggregation of MATSim’s legs to trips for analysis purposes), many more complex analyses are
just a few clicks away in Via, like showing the average duration of car-trips starting between 6 am
and 8 am, going from “home” to “work”.




